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Welcome to the IIFL Trader Terminal.

IIFL Trader Terminal is a comprehensive trading tool, with superior charting and
analytical capabilities. The latest version of  the Trader Terminal has a lightning fast
execution speed, world class user interface and a single?click access to our world?class
research. The new terminal offers the facility to trade in cash, derivatives, mutual funds,
IPOs, currencies and commodities, all in one screen.

On this trading platform you can conveniently trade on the following four Indian
Exchanges:
1. National Stock Exchange (NSE)
2. Bombay Stock Exchange (BSE)
3. MCX
4. NCDEX

Key features of  the Trader Terminal are:

• Streaming quotes, instant order confirmation, multiple market watches, alerts
• Single-click access to depository, ledger, MTM profit/loss statement
• Advanced charting options & technical analysis tools
• Customizable view
• Live-chat with customer care
• Live research and news updates
• Accessible from the desktop, over the web as well as mobile phones

Introduction
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Installation of  IIFL Trader Terminal is a very simple process.

• Download the application from the following link and then install:
http://content.indiainfoline.com/IIFLTT/EXE/IIFLTTClient.msi

• To access the terminal on web:
http://ttweb.indiainfoline.com

• To access the terminal on mobile use the following link:
http://ttm.indiainfoline.com

How do I access the IIFL Trader Terminal?

The IIFL Trader Terminal is optimized for use with a modem and an ordinary internet
connection. However, please check that your personal computer satisfies the following
requirements:

Operating system

The software is tested to work on Windows 98, Windows 2000, Windows 2003,
Windows NT, Windows XP, Windows Vista and Windows 7. On Windows 2000, NT
and 98 you will have to download .NET. Framework 2.0. In XP you will have to
ensure that you have upgraded your Framework version from 1.1 to 2.0

Proxy Setting

If the software is being accessed from behind a proxy you will need to open the
following ports
1) 10116 2) 25002

Browser version

IE 6/IE 7 and other popular browsers including Mozilla and Chrome

Hardware

Pentium/Celeron Processor with RAM - 256Mb. Ideally 512Mb and above.

System Requirements
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For logging on to your trading account, follow these simple steps:

• In order to logon to the EXE version, the web version or through your mobile,
you will be prompted to enter your Client ID and password.

• For the Web version, in addition to the password, you also need to provide your
PAN card number or date of  birth in the specified format.

Login
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Tip: This 2-level security has been provided to enhance security of  the terminal
and prevent unauthorized access.

• Ensure that you type your Client ID accurately. The system will get locked after 3
incorrect attempts

• It is mandatory to change your password the first time you login. Your password
should be alphanumeric and of atleast 8 characters

• On successful login, you are ready to use the Trader Terminal and trade @ lightning
fast speed

Tip: Passwords must be changed every fortnight
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Under this option you can create your own market watch, buy and sell scrips, analyse
the market real time and view charts

This menu is very useful to customers as they can view pending, executed or cancelled
orders during the day, open and closed Positions and also view their holdings at a
glance

The features under My Account help you to track your portfolio, check your P/L
summary, view digital contract notes, bills, confirmation notes etc. You can also transfer
funds from your bank account to your trading account and vice versa.

This menu directly links the Trader Terminal to the websites of  major exchanges, SEBI,
RBI, etc. You may also view IIFL Research by going to the IIFL Website

This provides you with research reports along with daily/weekly trading calls for buying
and selling of  equities, commodities and also mutual funds.

Menu Options

4



Manual

Market Watch

Market Watch is a window which enables you to view market information of  pre-
selected scrips of  your interest. Trader Terminal allows you to create and open multiple
Market Watch windows to help you view real-time scrip details on the sectors/ scrips
of  your choice simultaneously. You have the option of  selecting stocks from the default
lists or to create your own customized list.

Creating a market watch

• Go to Market > Market Watch > New or Press F4 on the screen

• To load any of  the pre-defined Market Watch, right click on the screen and select
Load group

• Select Predefined i.e. click on the + sign

• Double click on the desired option and the market watch would open

Adding scrips to the market watch

• Go to the Add Scrip option on top of the window and type the name of the scrip
in the Code/Symbol block. Press enter key.

• The scrip will appear in the Market watch

Saving your market watch

• Press Ctrl-S and save your Market Watch under a name

Tip: Always export the saved market watch to a desired folder on your computer.
This can be done by right clicking the Market Watch and going to the Export Scrip
List Option

Each scrip makes up a row of data that contains the scrip name, its last traded
price, last traded quantity, best bid rate, best offer rate, total volume, etc.

Features you might often use
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The market watch screen appears as follows in the different versions:-

EXE Screen

Web Screen

Customizing the Market Watch

The order of  the columns can be decided to suit one's convenience. To move a column
to the right or left, place the mouse pointer on the column heading and drag it to the
place of your choice.

You can also add/remove columns of  your choice. To do so, go to Tools > Settings >
Market Watch.

Simply check the columns you would like to see the in the Market Watch, and uncheck
the ones you want to hide.

Add Scrip

Click to view
scrip charts

Scrip Name

Add Scrip

Scrip Name

Real Time
Price Updates

Real Time
Price Updates
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Market Depth is a special feature of  Trader Terminal.
Market Depth details the following features:

• Real time scrip details

• View Best 5 Bid/Ask and Open Interest

• Check DPR: Daily Price Range - 52 Week High
and 52 Week Low

• Check ATP (Average Traded Price)

• The intra-day chart shows daily real time price-
volume data for a particular scrip

Accessing Market Depth

To view Market Depth, double click on the scrip on
your Market Watch. The Market Depth window will
open.

Market Depth
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Market Analyser is a unique feature which displays the current situation of  the markets.
This window provides the information on Top traded, Top gainers and Top losers.

It also provides a list of  scrips that have touched their 52 week high or 52 week low.
You may view the Market Analyser on Markets > Market Analyser.

Top Gainers/
Losers

Market Analyser
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In the Trader Terminal, you have multiple options to buy and sell scrips. You can use
any one of the following options to buy/sell a scrip:-

• Click the 'Buy'/'Sell' button available in each Market Watch.

• Right click on the scrip in your Market Watch, select Buy/Sell

• You may alternatively go to Market > Buy/ Sell.

• While using the EXE version you can also use the shortcut keys - F1 for Buy and
F2 for Sell.

Performing any one of  the actions mentioned above opens a Buy/Sell window. The
window provides options for placing a Market Order, Limit Order or a Stop Loss
Order

Tip: Please refer to FAQ's section to know more about the type of  orders

Global window for all products - This window lets you buy and sell products across
Cash, Futures, Options, Commodity, Currency or Mutual Funds.

On placing the buy or sell orders, you will get an instant confirmation on acceptance of
your order. These reports will also be available in your trade book.

BUY Order and SELL Order

9
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Now you can initiate a Buy/Sell order even after market hours. The order will be
processed on the next working day.

To place an AMO, go to Market > After Market Order > Buy/Sell.

Alternatively, you can use the following shortcut keys:

• For AMO Buy: Ctrl + F1

• For AMO Sell: Ctrl + F2

AMO (After Market Order) Buy and sell

Exe Screen
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Option calculator can be used to calculate the price of  options. It can also be used to
calculate the following :-

• The value of put and call options (The Black-Scholes Option Pricing Model)

• The implied volatility

• Probability of the underlying security reaching the target price

• Key statistics for analyzing option positions in the market

To access the Options calculator, click on the 'Option Calculator' in Market menu

Option Calculator

Exe Screen
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IIFL Trader Terminal generates several reports to assist customers to obtain a complete
view of  their portfolio and transactions. These reports have the following features:

• View order status

• Modify cancel orders from Order Book

• Cancel all orders on a single click

• Square off  open positions from Net Position window

• Exercise long open option positions from the Net Position window

• Directly sell from Holdings window

• View Margins utilized/ available

• Sort all reports by any column

• Export all reports individually or together on a single click

Order Book

Shortcut Key: F3

All pending orders can be seen in Order Book in the Reports menu option. You can
modify/cancel any or all pending orders at the click of a button.  The order book also
has all other details like time and price the order was executed.

Reports
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Trade book

Shortcut Key: F8

The Trade book shows all the details pertaining to the trades executed by you. The
trade book can be sorted on any of the columns therein.

Margin

Shortcut Key: F11

The Margin window shows you the real-time status of your Margins including margin
blocked for open positions and pending orders.
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Net Position

Shortcut Key: F7

The Net Position gives you real-time marked to market profit and loss report on your
trades for the day. It shows realized as well as unrealized profit or loss for your trades
for the day. You can square off  your open positions for the day with a single click using
the 'square off' button.

Holdings

Shortcut Key: F12

Press F12 on your EXE screen and get details of all your holdings in your demat
account as on the last working day. The Holdings Window also gives details on the
bought and sold quantity during the day. You can directly square-off  your position in
particular scrip by clicking the 'Square Off' button.
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Save to Excel

You can save the data from all crucial reports to an excel file by clicking on the 'Save'
tab under each report. These will not only help in analyzing the information later but
also help keep a record.
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You can view your ledger account under the My Accounts menu option. In this window,
you can also view details of each bill, each transaction and the balance of your Cash
and F&O ledger.

To access the ledger account, go to My Account > Ledger. Select the period and
product for which you wish to see the ledger, and click the 'Show' button.

Holders of a depository account with IIFL can view online all their holdings and
transactions in their beneficiary account under the DP option in My Accounts menu.

16

My ledger and DP

Date Range

Multiple Product
Option

Download
Excel/pdf

Ledger
summary
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You can easily transfer funds online to and from your bank to your trading account
using the Funds transfer option under the My Accounts menu.

• To transfer funds to your trading account, use the Fund Pay In option, wherein you
will be directed to the respective bank website

• To withdraw funds from your trading account, use the Fund Pay Out option. Fill
in the requisite details and click 'Pay Out'

17
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Payment
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Charts are a unique and useful feature in IIFL Trader Terminal.  To view the chart for
a scrip, select the scrip in Market Watch, then select Chart option in the Market menu.

The features of  the Charts tool available in Trader Terminal are:

• Streaming intraday tick-by-tick charts

• Historical Charts (1m, 3m, 6m, 1y, 2y, 5y, etc)

• Ability to chart multiple companies and open unlimited charts simultaneously

• Unique draw tools including trend line customization and Fibonacci tools

• 3 different chart type options such as Line, OHLC and Candlestick

• See each tick in Excel type grid, which is updated real-time. Also export to
CSV file

• Get Index charts by clicking on appropriate Index in the Index Watch window

18

Chart in EXE version

Indicators

Charts

Intra-Day/
Historical charts



Manual

Indicators available in Charts

1. Moving Averages 8. Exponential Moving Average

2. Weighted Moving Average 9. MACD

3. Bollinger Bands 10. Price Rate of Change

4. Relative Strength Index 11. Stochastics Oscillator

5. Average True Range 12. Momentum

6. Money Flow Index 13. On Balance Volume

7. Standard Deviation 14. Williams R

19

There are multiple analysis options available including 14 indicators for price and volume
panels which can be accessed by right clicking on the chart screen.
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The Trader Terminal gives you access to world-class research. IIFL research has been
acknowledged by Forbes as 'Best of  the web'and a '...a must read for investors'. You
can view company research, interviews with Industry stalwarts, analyst reports, news,
annual reports and quarterly reports on the Trader Terminal.

Our experienced team of research analysts also provides you with intra-day ideas in the
cash and derivatives segment to help you stay ahead of  the market. You also receive
market news throughout the day to keep you up-to-date on the various developments
in the market.

Market Mantra

Market Mantra is IIFL's daily
comprehensive research product which
covers market outlook, latest news,
economy snapshot, personal finance
insights, event notes, management meets
and research ideas for Equities, Derivatives
and Commodities

Weekly Wrap

IIFL Weekly Wrap comprises actionable
Ideas, Market Outlook, Commodity
Corner, Mutual Fund section, Event
Calendar and a comprehensive Chart book.
It also includes charts on Nifty Futures
VWAP and Bank Nifty Futures VWAP.

Research
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Enter message to be displayed
in the pop-up window

You can set price alerts for as many scrips as you wish using this feature. These alerts are
triggered and are designed to remind you of  certain benchmarks that you can set as per
your requirements. It alerts the trader when the scrips run more than or less than a
particular value, so that the trader can instantly buy or sell it.

The following screenshot shows the window where you can set the price alerts.

IIFL Calls

IIFL Calls gives you intra-day ideas in the cash, derivatives and commodities segment
to help you stay ahead of the market.

An alert pops up and prompts you to check if any updates are there.

Price Alerts
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Scrip name for which
price alert is to be set

Set the trigger rate for
the price alert

Scrip for which price alerts
have been set
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You can view your portfolio under the My Account menu option.

Portfolio Tracker

The Portfolio Tracker menu option tracks all your investments, cash flow and assets.

P/L summary

Your notional profit/loss is shown by marking total purchase/sales to the current
market value of  your securities. Cash and Derivatives segments are shown separately.

P/L Summary

Portfolio
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Sell value of
stock

Buy value of
stock

Security
Name

Buy value of
portfolio

Download
options

Securities in
Portfolio

Portfolio
Tracker
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To ensure security of  your account/terminal, an option of  locking the terminal has
been provided to prevent it from being misued. Locking your terminal disables the
trading feature. The application will however, keep receiving broadcast and other
messages. The display will keep updating itself  accordingly.

The terminal auto locks itself  after 10 minutes of  inactivity. This period can be
modified by you.

To lock the terminal manually, go to File > Lock

Lock/Unlock your Trading Terminal
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Do's

1. Change your Passwords every 14 days.

2. Keep your Internet Trading Passwords Confidential.

3. Clear your browser's cache regularly

4. Disable the "Auto Complete" function on your browser

5. Discard pin or password mailers immediately after memorizing them. Never write
them down.

Don'ts

1. Do not directly close your browser after you complete your online Trading session.
Log Off  from Trader Terminal before closing the browser.

2. Avoid downloading programs from unknown sources: Some sources may have
hidden forms of  spyware or viruses that could compromise the security of  your
computer.

3. Do not open attachments sent through mails, if  you do not know the sender.

4. Never open email attachments that have file extensions like .exe, .pif, or .vbs. Such
files are usually dangerous.

5. Do not keep computers online when not in use: Either shut the PC off or physically
disconnect it from the Internet connections.

6. Do not use shared computers: We recommend that you avoid accessing your
Trader Terminal from a public / shared computer, such as in a cyber cafe.

Do's & Don'ts while trading on IIFL Trader Terminal
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1. How to get your saved market watch when the Trader Terminal application

is updated?

Note that whenever the exe is updated the Market Watch groups saved by you
previously would not appear in the new exe. To retrieve your saved Market Watch,
follow the below procedure:

• Click F4. Right click and Go to the Import Scrip List option

• Import the list from the saved folder

• The saved Market Watch will open in the terminal

Tip: In order to avoid losing your saved Market Watch, always export your Scrip
List on to your Computer.

2. What is PLM and how does it work?

PLM stands for Primary Login Machine. During first time login, client will be
asked to either restrict (bind) or do not restrict the terminal to his system/computer.

• To bind/restrict the terminal, you need to select the option "Restrict my id to this
machine". Please note once the terminal is restricted to a system you will not be
allowed to login to terminal from another system or computer.

• If  do not wish to restrict or bind the terminal, you need to select the option "Do
not restrict my ID to this machine". Please note if  you do not restrict the terminal
you can operate the terminal from any system or computer

Note: If  you have restricted your terminal to a system and wish to operate the
terminal from another system, you need to go to => Tools => Reset PLM/
Binding before logging out from the terminal. If  you are unable to follow these
instructions due to unavailability of the same system/computer you may call our
Customer Service on 022-40071000 to unbind the PLM

3. What is the procedure for receiving password to login to terminal?

In case you have forgotten your password you can place fresh password request
online.

FAQ's



Manual 26

• Click on terminal icon

• Select Forgot Password on the login window

• Verify credentials

• Submit

Note: Password will be sent to you on your registered mobile number. You are
requested to change your password within 72 hours else password will be expired.
In case you are unable to request for password online you may call our Customer
Service on 022-40071000 to place your request.

4. What if you enter wrong password three or more times?

If you enter incorrect password three or more than three times your account will
be locked and you will get a message window stating "Too many attempts". Please
note that your account will automatically be released in 15 mins and you will be
allowed to operate your account

Note: In case of  urgency you may call our Customer Service on 022-40071000 to
unlock your account

5. What are the segments available while trading through terminal?

If your account is activated for online trading you can place orders in NSE and
BSE segment. To trade in F&O segment you need to submit written application
and income proofs for activating terminal in F&O segment

Note: If  the required details are already submitted, by default your terminal will
be activated in F&O segment and you will be able to place F&O orders. In case
documents are not submitted and you try to place the orders, the same will be
rejected by exchange. To activate the same you may call our Customer Service on
022-40071000 for assistance

6. What are STOP LOSS orders?

Stop Loss order is a tool used to limit the maximum loss on a position. It allows
the client to place an order only when the market price of the relevant security
reaches or crosses a threshold price specified by the investor in form of  'Stop Loss
Trigger Price'
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Example:

- Stop Loss BUY order

Suppose person A short sells Tata shares at Rs. 1150 with the expectation that the
price will fall. However, in the event that the price rises above his buy price, then A
would like to limit his losses. 'A' may place a limit BUY order specifying a stop loss
trigger price of  Rs. 1200 and the limit price as Rs. 1210. The stop loss trigger price
(STLP) has to be between the last traded price and the BUY limit price. Once the
market price of  TATA breaches the STLP (i.e. Rs. 1200), the order gets converted
to a limit BUY order at Rs. 1210.

- Stop Loss SELL order

Suppose person A buys Tata shares at Rs. 1150 with the expectation that the price
will rise. However, in the event that the price falls, then A would like to limit his
losses. 'A' may place a limit SELL order specifying a stop loss trigger price of  Rs.
1130 and the limit price as Rs. 1120. The stop loss trigger price (STLP) has to be
between the last traded price and the SELL limit price. If the market rate reaches
the trigger price, the SELL stop loss order is triggered and it becomes a plain limit
order.

Points to Remember:

• For placing a Sell stop loss order, both the rates must be lesser than market rates.

• Trigger rate should be greater than or equal to limit rate, but it should never be
lesser than limit rate while placing Stop Loss order.

• If  the rate entered by you in the trigger rate comes in the market, your sell stop loss
order gets triggered and becomes a plain limit order.

7. What is a Frozen Order?

There is a certain price range for each scrip that is decided by the exchange. If the
order placed by you is not in a proper price range then the order gets frozen or
rejected.

A frozen order is not executed and you will have to place a fresh order for the
same.
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8. What is a Disclose Quantity (DQ) Order?

In a regular order, the market quantity is disclosed in full to the market. An order
with a DQ condition/attribute allows disclosure of only a part of the order quantity
to the market.

For example, an order of  2000 with a DQ condition of  200 will mean that 200 are
disclosed to the market at a time. After this is traded, another 200 is automatically
released and gets executed. DQ should not be less than 10% of the order quantity
and should not be greater than the order quantity.

9. What is the market time to place after market orders online?

You can place After Market Orders between 4.30 p.m. to 8.30 a.m. online through
terminal.

10. How do I view scrips which are newly listed?

For viewing a newly listed scrip in your Market watch, you need to download
Scrip master from file menu and then select that scrip from the add scrip window.

11. What do I do if  the rates on my terminal are not refreshing?

If  the rates on your terminal are not refreshing, try the following options:-

• Exit and re-login to the terminal.

• Change the broadcast server from the file menu.

• If  the above options do not work, contact Customer Service.

12. Can I have more than one active Trader Terminals on the same Computer?

Yes. It is possible to use more than one Trader Terminal on a PC, as long as you are
logged in with two different ID's
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Error Message Particulars

Sent to IIFL Indicates that the order may or may not have reached the
server.  Hence, it is advisable to refresh the order book to
get the updated status

Rejected by RMS Indicates that order is rejected due to insufficient margins
available

Order does not exist Indicates that the order has already been executed and it
cannot  be modified or cancelled

Rate not within Indicates that the rate at which order is placed is either
circuit limits too high or too low in comparison to the rate currently

prevailing in the market.  Hence this order gets rejected.

Order value exceeds You need to contact Customer Service

Invalid client type Indicates that your account is not active for online trading.
To activate your account for online trading you need to
contact Customer Service on 022-40071000

Note: It takes 24 working hours to activate your account
for online trading after the same is requested by you

Broker/Order id Indicates that the scrip master is not downloaded at the
not set time of  release of  upgraded version of  Trader Terminal.

You need to update the scrip master by selecting the option
=> Master => Download Master

Error messages and their meaning
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We will always be happy to help you with any questions.

Please note our help desk contact details given below.

Call: (022) 4151 4151

Email: tt@indiainfoline.com

Customer Care: cs@indiainfoline.com

TT Help Desk
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Products on Trader Terminal
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Now you can invest in MF online

• Choose from 20 AMC’s and 1000 schemes

• All transactions get reflected in your demat account

• No additional KYC is required

• Simplified MF tracker especially for you

Trading in MF, just a click away!

To open an account

Call: +91 22 3944 0000          Write to us at: cs@indiainfoline.com
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Trader Multiple multiplies your buying power by giving you higher exposure
in specific stocks based on your available margin. It is an intraday product,
especially designed for smart investors who wish to take advantage of higher
trading margin.

Advantages of Trader Multiple:

• Traders can benefit from higher multiple on select stocks.

• Capitalise on research ideas and market opportunities using a higher multiple.

• Flexibility of placing a profit order and stop loss order at the same time.

• Limit your losses through stop loss order.

How to place a Trader Multiple order?

• Login to your trading platform entering existing login id and password.

• Click on Trader Multiple on the Market menu.

• Accept the terms and conditions to activate the Trader Multiple product.

• Select the Exchange, Scrip and Buy/Sell option.

• Put the desired quantity based on the margin available and place the order.

The orders in Trader Multiple are placed at Market Price by default. The

system will also place a stop loss order set at a difference of 4% from the

Market Price by default.
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Benefits of SIP

• Rupee Cost Averaging

• Easy and flexible investment

• Very low monthly investment possible

• Reduces Market Risk

• Disciplined Investment

Now invest in SIP through

ttweb.indiainfoline.com

and TT desktop

IIFL OFFERINGS

Equity SIP

Equity SIP allows you to

invest in a set of stocks

or exchange traded

funds at regular intervals

& beat market volatility

by averaging out the

costs.

e-Gold SIP *

Gold SIP's enable an

investor to invest in the

yellow metal in paper form

and save the investor the

hassles of storage. e-Gold

is more cost effective for

people who have a long

investment horizon.

e-Silver SIP *

Silver is the next most

traded commodity after

Gold. It is widely used in

industrial products and

thus raising the demand

for the metal.
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• Click on the tab Market Product SIP

*Note: e-Gold SIP & e-Silver SIP are traded through India Infoline Commodities Limited with NSEL.

Investment Tenure

Product Min (in Rs.) Max (in Rs.) Min Max Quantity

Traded

Equity SIP 3000 Unlimited 6 months 10 years 1 scrip

e-Gold SIP Prevailing cost Unlimited 6 months 10 years 1 gm

per lot

e-Silver SIP Prevailing cost Unlimited 6 months 10 years 100 gms

per lot

FEATURES

How can you invest through SIP?

To start investing through SIP, you will have to follow 4 easy steps as mentioned

below:

• Login to your trading account
using Client ID and Password

• Fill the required details • Accept the Terms & Conditions and
place the order
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